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Chapter 1 (Finder)

F i n d e r  S e c r e t s
Rebuild in System 6
System 6, too, has a trick for rebuilding the Desktop 
without having to restart the Mac. (You can’t use 
MultiFinder for this trick.) All you have to do is launch 
some program — Word, or whatever. Then, when you quit 
the program, press ⌘ and Option until you’re asked if you 
want to rebuild.

Trash can positions in System 6 and System 7
In System 7, you’re allowed to keep the Trash can 
anywhere on the screen; just drag it wherever you find it 
convenient. (In fact, you can have it in more than one place,
if you make an alias of it.)

In System 6, however, the Trash can always jumps back to 
its original position when you restart the Mac.

Chapter 3 (Desk accessories)

Under System 6, it was a running joke: they 
called the desktop the Finder, even though it had
no Find command. (System 6 users instead get a



desk accessory, called Find File, that locates 
files with all the pep of a petrified slug.

F i n d - F i l e  S e c r e t s
Search for fonts — and maybe sounds



In versions of the System up through 7.0.1, you can’t 
search for a screen font file (Times 12, for example). Even 
though these fonts are individually double-clickable, 
trashable, and viewable as icons, the Find command won’t 
find them. They’re hidden inside the System file; ditto with 
sound files, ditto with keyboard-layout files.

In System 7.1 and later, however, the Find command works 
for font files because they’re stored in the Fonts folder. In 
fact, if you use the trick in Chapter 21 for storing sounds in 
the Fonts folder, you can even search for those, too.

Successive, ever-narrowing searches 
In System 7.5, you can search for two or more criteria at 
once in the expanded Find File dialog box — by date and by
name, for example. (See Chapter 3 for specifics.)

To do the same thing in earlier versions of System 7, you 
have to perform repetitive searches, gradually narrowing 
down the icons you select until you isolate one specific 
group. Suppose, for example, that you want to find only the 
files created between January 1 and January 6. 

First, rule out all the older files by setting up the dialog box
as shown in Figure 2-8. 

Figure 2-8: Specify that you want only the files created on 1/1 or later by choosing the
“date created” and “is after” options from the pop-up menus. To set the date, you 
click the arrow buttons (you can’t type in numbers, as you can in the Alarm Clock 
desk accessory!). Be sure to select the “all at once” checkbox.

The “all at once” checkbox is powerful, slowish, and a little scary. Instead of simply 
highlighting one icon, it highlights all icons matching the scenario you set up. When
you click Find, the Mac creates one mammoth list-view window using the nested-
folder/triangle mechanism shown in Figure 2-9.



Now, here’s where things get good. Whatever you do, don’t click the mouse button 
now, or you’ll deselect everything and have to start over!

Instead, choose the Find command again from the File menu. (Yes, it’s okay to click
the mouse in a menu at this point.) This time, you’ll rule out all the files created 
after January 6 by setting up the dialog box as shown in Figure 2-10.

Figure 2-10: The important thing here is to choose the “the selected items” option from 
the third pop-up menu. In other words, you want the Mac to search through only the 
items you highlighted the first time around.

You’ve just done it; the first search ruled out the files created before 1/1, and the second
search ruled out (from the first group) those created after 1/6.

Incidentally, you don’t have to spend half an hour after each “all at once” search 
painstakingly closing folders that were opened by the Find command. In two 
keystrokes, you can collapse all those list-view folders: 



• Select everything in the window by pressing ⌘-A (or choose Select All from the 
Edit menu).

• Press ⌘-Option–left arrow to collapse all the open folders in the outline view. 
(Alternatively, switch to icon view and back.)

Find all locked files at once
Use the Lock item in the first pop-up menu to locate all the 
locked or unlocked files on a disk or in a certain folder. (You
use the third pop-up menu to limit the search to the folder 
that is open on the screen.)

D e s k  a c c e s s o r y  S e c r e t s

A fast Puzzle cheat
Suppose somebody gives you a customized Puzzle to solve. 
Here's the quickest way to see what the heck you're 
working on. With the Puzzle open, choose Copy from the 
Edit menu, and click the Desktop (so that you're back in the
Finder). Then choose Show Clipboard from the Edit menu. 
You'll see what the puzzle will look like when you finally 
solve it.

Chapter 7 (On, Off)

S t a r t u p  S e c r e t s  
System 6 to 7: stop that darned desktop-rebuilding
Every time you use System 7 on a particular disk after 
having used System 6, you have to sit and wait while the 
Mac rebuilds the desktop file. If you’re doing a lot of 
switching back and forth, this gets annoying in a hurry.

Our Secret, therefore, is that you can merrily click Stop in 
the Rebuilding the Desktop… dialog box that appears on 
the screen. You don’t hurt a thing by doing this, and you 
save yourself a lot of time. (A file or two may appear with 
blank icons, but they’ll return the next time you rebuild.)

If you have other disks, they, too, will go into rebuild-
desktop mode by themselves. Here, too, you can click Stop 



without compunction.

The only problem with this method is that the next time you
turn on the Mac, it will again attempt to rebuild the 
desktop. Of course, you can keep clicking Stop forever, but 
the Mac will also keep trying to rebuild forever, until you 
finally let it rebuild to completion.



A Mac you can’t turn on
First-time users are bound to be surprised when they first 
attempt to turn on the Color Classic. Pressing the power 
key on the keyboard does nothing unless the rocker switch 
in the back is on. But turning the rocker switch in the back 
doesn’t turn the computer on, either — unless you then 
press the keyboard power key.

Fortunately, after you have the computer home, you can 
leave the rocker switch in the On position permanently. 
Thereafter, you can use the keyboard power key exclusively
for turning on and off the Mac.

Chapter 8 (Disks)

D i s k  S e c r e t s
Eject a disk using only the keyboard
“Ah,” you protest, “you can’t eject a disk using the 
keyboard alone--you have to use the mouse, because you 
have to select the floppy’s icon before you can use ⌘-Y!” 
No, not if you’ve read Chapter 1 carefully. We know where 
you’re coming from, though; if some Finder window is open
on the screen, you can’t type a few letters of the disk’s 
name to select it, right?

Yes, you can, if you first press ⌘-Shift–Up Arrow, the 
keystroke that selects the desktop and makes all open 
windows inactive. Then type the first couple letters of the 
disk name, then press ⌘-Y. You’ve got it!

Erase fast
You can highlight the icons of more than one disk 
simultaneously (such as a floppy and a SyQuest cartridge) 
and use the Erase Disk command to wipe out both of them 
simultaneously. There’s not much time savings, actually, but
at least you don’t have to encounter all those confirmation 
dialog boxes more than once.

Express route to the Erase Disk command



If you hold down the ⌘, Option, and Tab keys while 
inserting a disk into your Mac’s floppy drive, the Erase Disk
command will be activated automatically as soon as the 
disk mounts. You’ll see the standard dialog box asking if 
you want to completely erase the disk you just inserted. Hit
return and the erasing begins.

Erase even faster
Apple makes a wonderful, superbly designed program 
called Apple Disk Copy. You can get it from a dial-up 
modem service such as America Online or CompuServe, or 
you can get it from a Mac user 



group, such as BMUG (415-549-BMUG). As a matter of fact,
this is about the only useful piece of utility software for 
which we couldn’t get the rights to include with this book. 
Apple wanted us to pay so many thousands of dollars (a 
“licensing fee”) that this book would have cost $85, and you
probably wouldn’t be reading it. (Weird, since they give it 
away free on those dial-up services…)

Anyway, Apple Disk Copy does one thing very, very well: it 
duplicates floppy disks. You insert the disk you want to 
copy; Disk Copy spits it out and then asks for the disk you 
want to copy onto. You can make as many additional copies 
as you want without ever having to reinsert the original 
disk.

It’s much faster than making copies the usual way, and it’s 
more accurate. Disk Copy doesn’t even care whether it’s a 
Mac or a DOS disk you’re copying.

Best of all — and this is why this tip is here — Disk Copy 
doesn’t waste any time initializing or erasing a disk before 
making a copy. Even if you insert a brand new disk, Disk 
Copy makes a perfect copy of the original disk (including 
window positions, icon positions, file names, disk name) 
without even having to initialize. 

When you buy a new box of disks, we recommend that you 
initialize the first one (name it Blank or something). Instead
of painstakingly initializing each of the other nine in the 
box in the usual way, just duplicate the empty disk using 
Disk Copy. This technique is faster and better.

Chapter 9 (Memory)
Virtual memory

We’re sure you already know this tip, but this is a great time to
remind you of it. Running a bunch of programs, any one of 
which fits in your Mac’s available RAM, but whose combined 
memory requirements are too much for your Mac, is the 
perfect scenario for using virtual memory. (See Chapter 8 for 
more on this unique, built-in System 7 feature.)



People sometimes avoid virtual memory based on its 
reputation for slowing down your Mac. But as long as each 
application you’re running would fit into your Mac’s RAM by 
itself, virtual memory only makes the Mac sluggish when you 
switch between them. While you’re working in a program, you 
won’t notice much slowdown at all.

Suppose that your Mac has four megabytes of RAM. Your 
System heap (the System plus all your control panels, 
extensions, and so on) is, let’s say, 2,000K. That leaves you 
with about 2,000K of memory in which to run your programs. 



Now suppose that you want to open Canvas (suggested RAM 
partition is 1,500K) and HyperCard Player (suggested size 
1,000K). Simple math shows you that either program can fit 
into the 2,000K of free memory, but not both. 

This is a perfect time to use virtual memory. The Mac will load 
Canvas into RAM, along with as much of HyperCard as it can 
fit. Then, when you switch to HyperCard, a chunk of Canvas is 
deposited onto the disk, and the remainder of HyperCard is 
fed into memory. As we said, you’ll only notice sluggishness 
when you switch between programs.

3 2 - b i t  a d d r e s s i n g  S e c r e t s

Turn off Mode32 temporarily
To turn off 32-bit addressing, open the Memory control 
panel. Click the Off button and restart the Mac.

If you use Mode32, you can temporarily disable it by 
pressing the Esc key on your keyboard as the Mac starts 
up. Your Mac will automatically run in 24-bit mode. 

If you look at the Memory control panel, however, you’ll 
still see that 32-bit addressing is turned on, which can 
confuse you. Don’t be alarmed — that’s just Mode32’s way 
of ensuring that your Mac goes back to 32-bit mode the 
next time you restart.

What to do if your Mac crashes in 32-bit mode
You probably have either (a) hard-disk drivers that aren’t 
compatible with 32-bit addressing or (b) a system extension
that’s not compatible.

It’s easy to find out which. Restart the Mac, but press the 
Shift key during startup, so that no extensions run. If 
everything goes fine, then one of your extensions is the 
culprit and you need to remove all of them. Add them back 
to the System folder a few at a time, restarting each time, 
until you figure out which one was causing the problem.

But if your Mac still keeps crashing, the problem may be 



your hard-disk driver (see Chapter 7). If updating that 
doesn’t solve the problem, consider any NuBus cards 
installed in your Mac’s slot — even some NuBus cards 
aren’t 32-bit clean.

So what if you can’t do without the program or the 
extension that’s incompatible? You’re not completely out of 
luck. To keep the older-style, more-compatible, 24-bit 
addressing but still expand your available memory beyond 
eight megabytes, you can buy a program called Optima 
from Connectix. It lets your Mac access up to 14MB of 
memory.



System 6 and 32-bit addressing
Actually, “System 6 and 32-bit addressing” is an oxymoron. 
If you use System 6, you can’t use more than eight 
megabytes of RAM because System 6 doesn’t offer a 32-bit 
addressing option.

On the other hand, Connectix does. They sell a program 
called Optima that grants 32-bit addressing powers to 
System 6 users. It works.

Sidebar: Answer Man

When 32 bits is just too much

Q: I understand about 32-bit addressing. But I’m in a real crisis. I have to use DNA Designer Pro,
a sophisticated gene-splicing utility. It’s not 32-bit clean — it crashes if I turn on 32-bit 
addressing — and yet it requires 9MB of RAM to run! What shall I do?

A: We’re perfectly aware that this is a setup. There can be no such thing as a 
32-bit dirty program that requires 9MB of memory. It wouldn’t run on any Mac!

But we’ll play along and pretend this is a real question. The real answer is to 
buy Maxima, a program from Connectix. It grants your Mac access to 14MB of 
RAM, without requiring you to turn on 32-bit addressing. If you have any RAM 
installed beyond 14MB, Maxima can use it as a RAM disk (see below), so that 
at least it’s 
not wasted.

The stutter-start phenomenon

Q: Something goofy’s going on here. When I turn on my Mac IIcx, it seems to
start loading, and then it suddenly dings again and starts a second time. 
What’s happening?

A: Your Mac IIcx is among the “32-bit dirty” Macs: the II, IIx, IIcx, and SE/30 
models. In order to use more than 8MB of memory, you installed an extension 
— either Mode32 or Apple’s 32-bit enabler. (All of this is made much clearer in
Chapter 8.)

But to bestow 32-bit addressing unto these models, the extension must load 
into memory and then restart the computer in the Mac’s new, memory-
enhanced mode. That’s why your Mac seems to do a double startup when you 
turn it on.

end sidebar 



Chapter 11 (Monitors)

M o n i t o r  S e c r e t s  
Surviving the 12" monitor
As we’ve mentioned, Apple’s low-cost 12" color monitor 
wasn’t its crowning achievement in planning. There’s 
nothing wrong with the monitor itself. The problem is that 
too many programs were written with the assumption that 
the standard Mac color monitor is 13". If you run these 
programs on a 12" color monitor, part of the picture — 
sometimes an important one — is chopped off at the bottom
and right side. Games, especially arcade-type games, are 
particularly likely to be unusable on a 
12" screen.

Here’s a workaround that may help you scrape by: get a 
program called Stepping Out II (Berkeley Systems, 510-
540-5536 (ed note: no longer sold]). This program uses 
some of your Mac’s memory to create a larger “virtual 
screen” than the one your Mac really has.

It works like this: your monitor behaves like a window onto 
a larger canvas. When you move the mouse to the edge of 
the screen, the entire screen picture scrolls to the side, 
bringing a new part of the virtual screen into view. It’s not 
as good as having a full-sized monitor, but it may get you 
past the tight spots.

sidebar: Macintosh Secret

The word Monochrome

We’ve heard an alarming number of people saying, “Aw, I don’t need color or 
grayscale. I’m just gonna get a monochrome monitor.”

That’s a contradiction, chum.

Monochrome means “one color.” It doesn’t say you can’t have different 
shades of that color. In other words, monochrome means grayscale, not black 
and white.

end sidebar 



Chapter 12 (Mac by Mac)
begin sidebar: Macintosh secret



Losing the drive

Apple's marchers for progress have stepped aside to make way for the 
marketing staff. First, Apple replaced its terrific SuperDrives of old with a new 
style that doesn't grab the disk out of your hand. In this new drive @md which
you'll find in all recent Macs @md you have to push the disk all the way in 
until it disappears.

And it's only going to get worse: a recent Apple newsletter indicated that the 
auto-eject feature of today's SuperDrive floppy drives will soon become an 
expensive option. New Macs will feature a floppy drive that gives up its disk 
only when you push a manual-eject button.

We're guessing that this is Apple's response to the whiners who complain that 
IBM clones are less expensive than Macs @md the same people who ignore all
the ways in which a Mac is better than those clones. Apple seems to be 
saying, "Hey, if you really want us to compete in price, let us compete in less-
featured equipment."

end sidebar

M a c - m o d e l  S e c r e t s
PowerBook 170 pixel problems
The 170's active-matrix display is gorgeous, but the display 
is plagued by one flaw that has driven some users 
absolutely crazy. It's not uncommon for a few of the 
256,000 pixels on the 170's display to get stuck 
permanently on, glowing white no matter what is supposed 
to be on-screen. (See Chapter 10 for insights on why this 
happens.)

The bad news is that Apple doesn't consider this situation 
to be a defect unless (a) at least five pixels go bad or (b) 
two of the broken pixels are within one inch of each other. 
If a few defective pixels are scattered across the screen, 
Apple won't do anything about it. Obviously, then, if you're 
in the market for a used 170, scrutinize its screen carefully 
before you purchase. (This is true of all PowerBooks with 
active-matrix screens.)

Keeping a Mac Portable awake
To conserve battery power, Mac Portables automatically 
lapse into a dormant state if no mouse, keyboard, or 
peripheral activity occurs for 15 seconds. Unfortunately, 



this feature also can slow any automated routines 
performed by the Mac.

To disable the Automatic Sleep feature, open the Portable 
control panel and click the words Minutes Until Automatic 
Sleep while holding down the ⌘ and Option keys. Choose 
the "Don't Rest" option in the dialog box that appears. The 
computer remains on, at full power, until you change this 
setting.



A Portable battery Secret
Don't let the lead-acid battery in a Portable become fully 
discharged; it can become unusable. If the battery's charge 
drops below 5.4 volts, it no longer takes a recharge. A 
Portable's battery is being slowly drained even when the 
power is off. So don't put your Portable on a shelf for 
weeks; keep it plugged in regularly to keep the batteries 
freshly charged. (See Chapter 12 for more insight on this 
and other portable Macs.)

begin sidebar: Macintosh secret

More products daily

In 1984, Macworld magazine carried a one-page advertisement for 
MacConnection, a major mail-order house, offering a full inventory of @md 
brace yourself @md 27 products for the Macintosh. Of those listed, a dozen 
were accessories, such as dust covers, surge protectors, and floppy-disk 
cases. Of the 15 actual programs available to Mac owners, 10 were games. 
The advertisement did, however, promise that "more products are arriving 
daily."

Obviously, it was true. A typical 1996 MacConnection ad lists more than 1,000 
items and covers seven pages of the magazine.

end sidebar

Shutting-down Color Classic weirdness
You turn off the Color Classic differently than you do most 
Macs (until System 7.5, that is). Instead of choosing the 
Shut Down command from the File menu, you press the 
Power key on the keyboard. You'll be asked whether you 
want to shut down. Click OK. After each program quits (and
offers you the chance to save your work), the machine turns
itself completely off.

Color on a Classic II?
The Classic II has a black-and-white monitor, but it does 
have 32-bit QuickDraw in its ROM. Therefore, it can display
color and gray-scale information. Because it has no 
expansion ports, however, you need a third-party device 
@md such as Radius' PowerView or Aura Systems' Scuzzy 
View @md to connect the Classic II to a color monitor 



through the SCSI port. (That arrangement offers relatively 
slow video-display speed.)

Avoid overheating
A general rule when working with compact Macs: be 
careful about placing objects on top of or against the sides 
of the computer. The air vents on the casing are vital to 
internal air circulation. Without 



adequate ventilation, the innards of the computer can 
overheat and get damaged. This warning applies especially 
to the Plus; it was the last Mac model produced without an 
internal fan for cooling.

Changing the internal battery
A small 4.5-volt battery is responsible for keeping the Mac 
Plus's internal clock ticking after you shut down. You need 
to replace this battery after about two years. This is a do-it-
yourself job on a Plus. Pull the battery out of its 
compartment on the upper-right side on the back of the 
computer case. Replace it with an EverReady 523BP, Ray-O-
Vac RPX21, Duracell PX21, or Panasonic PX21.

PowerBooks and their RAM disks
A PowerBook 100 is unique. It’s the only Mac whose RAM 
disk is never wiped out, even when you shut down the Mac.

The other PowerBooks safely preserve their RAM disks, 
right there on the desktop, when you put them into Sleep 
mode — but not when you shut them down.

How to set the cache in System 6
If you study our guidelines for setting your Disk Cache, 
you’ll come to this conclusion yourself. But we’ll do the 
math for you: in System 6, the most RAM your machine can
use is 8MB. Therefore, never set the System 6 RAM Cache 
higher than 128K. The lowest you should set it is 32K.

sidebar: Answer Man

The double-blink at startup

Q: Help! I just installed Mode32 onto my IIcx, as you seem to be 
recommending. I turned on the 32-bit addressing function in the Memory 
control panel. But when I start up the Mac now, before the smiling Mac 
appears, the screen seems to “jolt.” And for a split second, there’s a quick 
checkerboard pattern mid-screen. Then, suddenly, the smiling Mac appears, 
and everything’s fine.

A: Mode32 does some clever and devious things to make your Mac 32-bit 
clean. This “double-boot” business is just the way it works. It’s normal. Don’t 
sweat it.



end sidebar

Chapter 13 (Power Macintosh)



sidebar: True Fact

The history behind the history makers

As the 1990s dawned, the battle lines were drawn in the computer industry. 
Microsoft (software) and Intel (chip maker for IBM compatibles) dominated 
personal computers. Apple, Motorola (chip maker for Macs), and IBM were 
down on their luck and worried about the future. The latter three formed the 
PowerPC alliance in an effort to swing fortune their way.

The alliance couldn't set up shop at one headquarters or another; the cultures 
(Apple's jeans-and-T-shirt, IBM's button-down) were too different. So a new 
facility was built in Austin, Texas. The companies called it Somerset, after the 
location of King Arthur's Round Table, where the knights were supposed to 
check their quarrels at the door. About 350 people work at Somerset. Most of 
them came from IBM, Motorola, or elsewhere in the industry; only six people 
there work for Apple, a company that never did make processor chips.

The group's main efforts are directed toward developing the 603, 604, and 
620 chips. Believe it or not, the PowerPC 601 chip found in the first-generation
Power Macs wasn't developed by this alliance. Instead, this particular chip was
designed @md and nearly completed @md by IBM for use in its workstations. 
Apple and Motorola, in a hurry, merely adapted it.

A fake-out FPU for the Power Mac

As we mentioned, a few high-end programs (scientific analysis, modeling, and 
so on) crash on the Power Mac because they require the old-style math 
coprocessor chip (FPU), which the PowerPC chip lacks.

If you're a modem-savvy person, you can trick about 75 percent of these 
programs into working on the Power Mac; just install the $10 shareware 
program Software FPU (available on America Online or another on-line 
service). It's much, much slower than a real FPU (although not so bad for 
Photoshop filters), but at least it'll carry you through until your high-end 
programs are released in native versions. On the other hand, some programs 
run extremely slowly in emulation; Microsoft Excel 4, alas, is one of them.

The missing FPU (and the emulation process) hits this program particularly 
hard, grinding its spreadsheet recalculations nearly to a halt. Some 
calculations can take 20 times longer on a Power Macintosh than on a Quadra 
800.

end sidebar



Chapter 14 (PowerBooks)

In the first year of its existence, the Duo's sales 
didn't skyrocket. It was too hard for people to 
understand, we kept hearing. There were some 
reports of mechanical problems: the original 
keyboard had a numb spacebar, for example, 
that would sometimes fail to type a space when 
you pressed it.

Then there was the Apple Express Modem, a 
$300 high-speed internal modem for the Duo. 
For a year, it was the only internal modem on the
market for the Duo @md and it was trouble-
prone.

But Apple has cleared up the Duo's mechanical 
flaws. If you have the unresponsive Space bar, 
call 800-SOS-APPL, and they'll happily send 
someone to pick up the Mac, install a redesigned
keyboard the next day, and overnight it back to 
you, all for free. The new keyboard is no bigger, 
but the touch is better and the keys all work. As 
Apple has updated the Express Modem's 
software, it's gotten better, too.

begin sidebar: True Fact

SCSI Disk Mode when your Mac has no drive

If you have an old Mac that still, after all these years, has no internal hard 
drive, the cabling arrangements for hooking up to a PowerBook in SCSI Disk 
Mode are slightly different.

* Classic series, LC series, IIfx: Desktop Mac → normal SCSI cable
→ (any other SCSI devices) → the terminated PowerBook/cable ensemble



* Portable (with or without internal drive) or Mac Plus: 
Portable/Plus → normal SCSI cable → unterminated PowerBook/cable ensemble

* Any other Mac: Desktop Mac → normal SCSI cable → a 
terminator → (any other SCSI devices) → the terminated PowerBook/cable 
ensemble

end sidebar

Another Battery DA failing

There's another problem with the Battery DA. If you use a 
PowerBook 100-something, you can't tell when your battery is 
recharging! When you plug in the Mac, and open the Battery 
desk accessory to see whether or not you're receiving power, 
you'll see the lightning-bolt icon regardless of whether or not 
the outlet is working. In fact, you'll see this "now 



recharging" icon even if the far end of the PowerBook's 
adapter cord isn't plugged into anything!

On the PowerBook 100 series, it actually takes about 20 
minutes before the Mac displays a message saying that your 
battery isn't, in fact, recharging. (Later PowerBook models are
much smarter; the Control Strip tells you instantly whether 
you're plugged in.)

Therefore, let us make our profoundly low-tech suggestion to 
anybody who travels with a PowerBook 100-something: take a 
night light. Spring the $1.59 on some cheapo Disney-character
night light. Sock it into your PowerBook carrying case. When 
you want to confirm that some outlet is actually working, 
shove Mickey into it and get an immediate answer.

Notes on the startup chime

The PowerBook’s wonderful second-inversion C triad startup 
sound has a breathy, relaxing feel to it. But there’s nothing 
relaxing about the angry glare you’ll get from the sleeping 
passenger next to you if you’re continually chiming away (each
time you restart, for example).

The beginner can’t be blamed for making a racket; it turns out
that, unlike most other Macs, the PowerBook 100-series’ 
startup chime is controlled by the sound level you’ve set in the
Sound control panel. Set it at 7 and you get a loud startup 
chime. Set it at 1 and you get a soft one.

Set it at zero, though, and you get the loudest startup chime!

We don’t know what sense this makes, either, but we have two 
solutions to propose. First, go ahead and set the speaker level 
to 1. The resulting chime is pretty darned quiet.

The second method is to plug some miniplug into the speaker 
jack in back of the PowerBook. A miniplug is the little pinlike 
affair found on the end of Walkman headphones, for example. 
In fact, a pair of Walkman headphones does just fine for this 
purpose; anytime a miniplug is in the PowerBook’s speaker 
jack, no sound comes out of the PowerBook speaker at all. 



Of course, it’s less klutzy to get a miniplug that’s not 
connected to headphones or anything else — just a miniplug. 
You can get one at a Radio Shack, or you can snip one off the 
end of some stereo cable (or off a pair of Walkman 
headphones!).

Or just get a later-model PowerBook; later-model PowerBooks’
and Duos’ startup chimes shut up completely when you set the
Sound volume to zero.

sidebar: Macintosh Secret



PowerBook 100 battery notes

You’ll read, if you haven’t already, our advice to discharge a PowerBook’s 
battery completely every couple of months. This does not apply to the 
PowerBook 100, however. Its lead-acid battery is very different and may 
actually be damaged if you let it drain away to nothing.

Under normal working circumstances, this can never happen. The Mac will let 
you know when the battery is approaching that danger point, and it goes to 
sleep before the battery becomes too depleted.

However, once the computer’s asleep, the risk remains that the tiny trickle of 
power (that maintains a PowerBook’s memory while the computer is asleep) 
will deplete the battery to the danger point if it’s left untouched for weeks.

That’s why, on the left side of the back panel (right next to the power-adapter 
jack), there’s a battery cutoff switch. If you’re going to be storing the 
PowerBook 100 for a long time, flip this switch downward (Off) to prevent 
further depletion.

end sidebar 

P o w e r B o o k  S e c r e t s  
Recover from your Duo’s window deprivation
The Duo’s elegant gray-scale screen leaves only one thing 
to be desired: the shading of the windows. Any desktop 
Mac in gray-scale mode shows a nice 3-D tinting to its title 
bar and scroll bars, but not the Duo.

Having read Chapter 3, you know how to adjust whatever 
color scheme the PowerBook uses for these accents (with 
the Color control panel). But you’ll find that, weirdly 
enough, on a Duo nothing happens at all when you choose 
from among the delicious-sounding choices.

It turns out that the black-and-white window phenomenon 
is a side effect of the Duo’s System Enabler. 

In theory, you can restore the tinting to your windows as 
follows: Start up the Duo from your Disk Tools disk. Launch
ResEdit, included with this book, and open the System 
Enabler inside your Duo’s System folder. Find the icon 
called WDEF and click it. Then choose Cut from the Edit 
menu, save, and restart.

We say in theory, because we tried this twice. Once it 



worked beautifully and restored the gray tinting to the 
windows. Another time it made our windows act funny. 
Both times we restored everything by reinstalling the 
System folder.



Carrying the Duo
At this writing, there aren’t even any carrying cases on the 
market that are designed to fit the PowerBook Duo.

So one of your cheerful co-authors used a Magenta 7 
carrying case designed for the original PowerBook — the 
smallest he could find — to carry his Duo. Turns out that if 
he put the MiniDock onto the Duo, its added bulk made the 
Duo just about fit right into the case.

But eventually, a funny problem turned up: the lower mouse
button seemed to be losing its alignment and 
responsiveness. Turned out that this non-rocket scientist 
had been inserting the Duo/MiniDock unit into the case 
front-edge first. If you’re familiar with the Duo, then you 
realize what that also meant — mouse button first. (The 
Duo’s lower trackball button wraps all the way around the 
front edge of the machine like a protruding lower lip.)

And that put the combined weight of the Mac and its dock 
onto the mouse button as the entire affair was carted 
around the violent city of Manhattan. No wonder the lower-
lip button got cranky.

Today, this author still uses the same carrying case and 
transportation scheme (attaching the MiniDock before 
traveling). Now, however, he puts the MiniDock edge into 
the case first, and hasn’t had any further problems. 

Come to think of it, this advice probably applies even if the 
Duo isn’t attached to a MiniDock.

Using a recharger
As we’ve mentioned, the PowerBook battery recharges 
automatically whenever it’s in the Mac and the Mac is 
plugged in.

If you’re a serious PowerBook mogul, though, with several 
additional batteries, you may find it worthwhile to buy an 
external battery recharger. Apple sells one that juices up 
two batteries at a time (but this takes twice as long as 
charging just one). It’s a little awkward because it requires 



the PowerBook’s wall adapter — which, therefore, you can’t
be using with your Mac at the same time.

One tip about Apple’s recharger: don’t leave batteries in 
the recharger when it’s not plugged in. You’ll wind up 
draining the batteries all over again.

You can buy a recharger from Lind Electronic Design, too 
(612-927-6303). It’s more expensive, but does more for you.
In addition to giving you a set of lights that indicate the 
battery’s current charge status, it can deep discharge your 
battery. (This, as we’ve mentioned, is the cure for the 
memory effect, and keeps your battery in tip-top condition.)



Chapter 16 (Multitasking)

Here are a few great uses for Publish and 
Subscribe:

n Create a chart in Excel and publish it. Import it (subscribe) into a report you did in a word 
processor. Each month, when the numbers change, you can update the numbers in the spreadsheet and print 
out the updated report with very little effort.

n Do an advertisement in FreeHand or Illustrator. Publish it and subscribe to it from a page-
layout program. When the specs or prices listed in the ad change, edit the original graphic in the drawing 
program. You’ve saved the time of re-importing, placing, and sizing the graphic.

n Publish from one Word document — or even part of a document — to another. When you 
create a presentation, for example, write your speech and the audience-handout text on the same page (which
you’ll be looking at). Then publish only the audience-handout text into a separate document, which you can 
print and hand out.

M u l t i t a s k i n g / P u b l i s h  a n d  S u b s c r i b e  S e c r e t s  

Easy Open and System 7 Pack: Make substitutions 
permanent
What if you want all documents of one creator type to be 
changed at once to another?

Here’s where System 7 Pack comes in handy. We’ve 
included this program with the book (see the SECRETS 
disks). Among its other features, System 7 Pack lets you 
specify replacement creator codes for your documents.

System 7 Pack lets you set up substitute type codes for a 
more successful double-clicking experience. In this 
example, TEXT means a text file, PICT means a graphics 
file, and MACA is a MacWrite document. They’ve been told 
to auto-open as TeachText, Photoshop, and Word 
documents, respectively.

(The shareware version included with this book lets you 
specify up to three such pairings. If you register System 7 
Pack, you’ll get a password over the phone that “unlocks” 
the feature, giving you an unlimited number of application-
substitution pairs.)

If you’d prefer a more flexible and official version of the 
same thing, you can buy Apple Easy Open (or get it with 
System 7.5, a Performa, and so on). This System 7 
extension has even more intelligence. If you double-click a 



Finder icon whose parent application doesn’t seem to be on
the disk, you don’t get the “application not found” message.



Instead, you get a neat list of every program you own that 
can open the document. You can choose which program you
want to open it.

If and when software companies make their programs Easy 
Open-compatible, this tool will become increasingly more 
useful. You’ll be able to double-click a MacWrite file, for 
example, and choose from among several programs that 
have appropriate converters.

How Excel 4.0 does Publish and Subscribe 
Excel 4.0 doesn’t show those thick gray borders around 
material it has published or subscribed to. And it doesn’t 
have Publisher Options or Subscriber Options commands in
the Edit menu. 

Instead, these options are offered in a place you’d never 
think to look — the Links command in the File menu. When 
you choose it, you get a list of all publishers in the 
document or, if you use the pop-up menu at the top, a list of
all subscribers.

What’s neat is that you can double-click any publisher or 
subscriber in this list. The dialog box closes, and you’re 
taken directly to the place in your spreadsheet containing 
the selected information.

Note, too, that this dialog box contains an Options button. 
This button displays the usual Publisher Options or 
Subscriber Options dialog box. You have the same old 
choices — Get Edition Now and so forth — they’re just 
hidden away behind this button.

Actually, you don’t have to use this hidden-away version. 
You can also bring up the Publisher Options or Subscriber 
Options dialog box by double-clicking a published or 
subscribed area in the spreadsheet. (This doesn’t work for 
charts you published. It does work for charts to which you 
subscribe, and it works for all other data types, both 
published and subscribed.) 

In Microsoft Word: linking entire documents, or not



You can publish all the text in a document, if you wish. Be 
careful what you select, though. If you use the Select All 
command to highlight the entire document including the 
final paragraph mark (see Figure 16-22), then you won’t be 
able to add anything to the end of any new document you 
create that subscribes to the edition.

Figure 16-22: In Word, turn on the Show ¶ command in the View menu. Now you 
can see the ¶ marking at the end of the text. If this marking is selected when you 
create the edition (top left), then you won’t be able to add any text to the end of the
subscriber document (bottom left). On the other hand, if you stop the selection just
before the final paragraph mark, you’ll be able to add more text to the end of the 
document (right).



Publish and Subscribe in Photoshop
We want to reiterate that every program’s Publish and 
Subscribe commands are slightly different. Take Photoshop,
for example, which has only two commands: Create 
Publisher and Publisher Options.

Furthermore, we said earlier that the Create Publisher 
command is dimmed unless you select some material. But 
in Photoshop, Create Publisher is dimmed if you have 
selected something! What’s going on?

Photoshop is, at its core, a painting program. By nature, its 
entire screen is one solid bitmapped graphic. It doesn’t 
have lots of discrete objects, like a drawing program (such 
as MacDraw) or a word processor. Therefore, you can only 
publish the entire document at once. (That’s why the 
Create Publisher command is dimmed if anything is 
selected.)

Since you can’t very well subscribe to text or object-
oriented graphics (because they have to be treated as 
distinct objects in order to be individually updated), there’s 
no Subscribe command at all. Finally, since you can’t 
publish only part of a Photoshop document, the Publisher 
Options command is only available after you’ve published 
the entire image…whereupon the Create Publisher 
command is dimmed! In other words, of Photoshop’s two 
Publisher-related commands, at least one is always 
dimmed.

Give Photoshop credit, though; most painting programs 
have no Publish and Subscribe commands at all.

sidebar: Macintosh Secret

Switch-launch into MultiFinder

As you know, the instructions for using MultiFinder say that turning 
multitasking on and off involves restarting the Mac each time. In a given work 
session — that is, one time that the Mac is turned on — it can only be in 
MultiFinder mode or not.

This isn’t perfectly true, however. Here’s an undocumented tidbit that lets you
use both Finder and MultiFinder in the same work session.



Start up the Mac with the regular Finder. When you want to switch to 
MultiFinder, open your System folder. While pressing ⌘ and Option, double-
click the MultiFinder icon. Your Mac will jump-start into MultiFinder without 
your having to restart the machine.

To go back to single Finder, however, you still have to use Set Startup and 
restart the Mac; this is a one-way Secret.

end sidebar 



Chapter 17 (Word Processing)
About Word 5’s Glossary

In versions of Word prior to 6.0, you can store frequently used 
words, phrases, graphics, table formats, and graphics in the 
Glossary — and then retrieve them with a couple of 
keystrokes. The Glossary is one of Word’s great built-in, labor-
saving devices, but it’s one that is all too often ignored by 
users of the program.

In Word 6.0, the Glossary command has been renamed 
AutoText. It works a little bit differently, but the idea is the 
same: You can store chunks of text and have Word retrieve 
them for you on command.

Suppose that you’re a newspaper reporter (as Joe, one of your 
cheerful authors, was for years). Putting together crime 
stories, you routinely write that an individual “was arrested 
and charged with” some crime. You can save that 29-character
phrase as a glossary entry and give it a short simple name, like
ar. In the future, all you have to do is hit the glossary 
command, type ar, and hit Return (or just click the AutoText 
button in Word 6.0). Word will type the phrase into your 
document automatically. But wait, it gets better: Assign this 
same glossary entry its own keyboard shortcut using the 
Commands command (in Word versions 3 through 5) or the 
Customize command (version 6.0), and you’ve reduced 29 
keystrokes to one! (See the section called “The Commands 
command and Customize” in this chapter for more on 
assigning custom keystrokes.)

Here’s another example: If you have a graphic you often use as
a logo or letterhead, you can save the graphic as a glossary 
entry called “logo.” To add the graphic to a document, you 
simply use the glossary command and type logo.

Word also has preloaded glossary entries that automatically 
type in the date, time, file name, author, or other basic 
information. You can scroll through these standard entries in 
the Glossary window.
Creating a new glossary entry



Here’s how you define a new glossary entry in versions prior to 6.0:

1. Select the text, graphic, or anything else you want to store in the 
glossary. A glossary entry can be any length — even pages long.

2. Choose Glossary from the Edit menu or press ⌘-K. The Glossary window 
appears (see Figure 17-19). Type in an easy-to-remember name in the empty name field.
Glossary entry names can be up to 31 characters long, but, obviously, a long glossary 
name defeats the whole point of this feature (retrieving a chunk of text with as few 
keystrokes as possible).

3. Click Define or press ⌘-D.



4. Close the dialog box.

If you’re using Word 6.0, you define new AutoText entries by selecting the text you want
stored, choosing the AutoText command from the Edit menu, typing in the name of the 
entry, and clicking the Add button. 

Inserting a glossary entry into a document

You can insert glossary entries into a document by choosing them in the Glossary 
window and using the Insert button, but that takes entirely too long. Use one of the 
methods below:

■ The fast way to insert glossary entries. Press ⌘-Delete. The status bar at the lower-left corner of 
the document window becomes highlighted and the word Name appears. Type the name of the glossary entry you 
want to retrieve. Then press Return or Enter. The glossary entry is inserted into the document at the insertion 
point (see Figure 17-20). Don’t try this in Word 6.0 — the ⌘-Delete key combination now performs the Delete 
Previous Word command! Instead, type the name of the AutoText entry right into the document and click the 
AutoText button (or press ⌘-Option-V).

■ The really fast way to insert glossary entries. Use the Add to Keys command described 
below to create a keyboard command for the glossary entry. You’ll bypass having to enter the name of the 
entry at all. In Word 6.0, open the Customize dialog box, select AutoText from the list of categories, and then 
select the entry you want from the list of available AutoText entries. You can then assign this AutoText entry 
its own keystroke or place it on a menu or a toolbar button.



Remember, you can store just about anything in the Glossary — a preformatted table, large graphics, even an 
entire form letter. Cumulatively, this feature can save you thousands of keystrokes, especially when combined 
with the Add to Menu and Add to Keys features.

Saving a glossary

This is one of Word’s dirtiest, not-so-little secrets. Ever stop to think about how you 
save all the changes you make to your glossary? 

With the Glossary window open, choose Save from the File menu. Or you can wait until 
Word asks you if you want to save it (when you quit the program). In either case, you’re 
supposed to save your glossary as Standard Glossary, right into the folder that already 
contains the Standard Glossary. Inevitably, you get asked “Replace existing ‘Standard 
Glossary’?”

We like to think that this “Replace existing?” message is a last-chance warning that the 
Mac gives. It’s supposed to mean you’re about to make a mistake. 

But in Word, this is what you’re supposed to do to save changes to your Glossary! We 
can’t think of a more poorly designed feature.

Oh, and incidentally: if, when quitting Word, you click any of the three No or Cancel 
buttons you encounter, thus electing not to replace the existing Glossary, then all your 
new Glossary entries are gone forever.

Fortunately, Microsoft cleared up this goofy scheme in Word 6.0. AutoText entries get 
saved into your default document configuration automatically.

sidebar: Macintosh Secret

To format or not to format

As you create glossary entries, keep in mind that in some cases you want to 
preserve an entry’s format and in some cases you don’t. If you save your 
letterhead in the glossary, for example, you want to keep the formatting intact
so that the letterhead looks the same every time you insert it. But for entries 
consisting of boilerplate text — words or phrases you insert into a variety of 
documents — you want the entries to match the format of whatever 
paragraph they are inserted into.

Here’s the secret: If you want formatting preserved with an entry, select the 
paragraph mark (the gray ¶ symbol that appears at the end of each 
paragraph when you choose Show ¶ from the View menu) along with the text 
when you create the glossary entry.



If you want glossary entries to take on the style and formatting of the 
paragraphs into which they are inserted, don’t select the paragraph mark 
following the text when you add the entry to the glossary. (In Word 6.0, you 
also have the option of saving AutoText entries as plain text or with formatting
attached.)

end sidebar 

Word 5’s Commands command 
To view the complete selection of Word commands in 
versions prior to 6.0 and to move items from one Word 
menu to another, you must use the Commands dialog box. 
(see Figure 17-23). You open it by choosing Commands 
from the Tools menu, as shown in Figure 17-23,  or by 
pressing ⌘-Option-Shift-C. (In Word 6.0, you use the 
Customize command to load up, remove, or relocate 
commands.)

The Commands dialog box (see Figure 17-24) shows a 
scrollable list of every Word command, whether or not it 
currently appears in a menu. A short description of each 
command is displayed in the Description field. By selecting a 
command and clicking Do It, you can perform any of the 
commands in the list. 

More importantly, by selecting a command and clicking one of 
the Add buttons, you add the command to the menu of your 
choice, select a keyboard shortcut for the command, or both.

To add a command to a menu, select the command you want to
add. Then use the Menu pop-up menu to specify which menu 
the command should appear in. Use the Add Below pop-up 
menu to determine where on the selected menu the item 
should appear.



You can even use this feature to move commands from one menu 
to another. So if you think Page Preview command really belongs 
in the View menu instead of File, you can do it. Or if you’d rather 
have the Word 



Count command at the top of the Tools list instead of further 
down, you can move it up. 

 

To move commands around, first select a command from the 
list in the Commands dialog box. Then click Remove. Use the 
pop-up menus to select the new location of the item. Finally, 
click Add.

Here are a few commands worth adding to your menus:
■ Allow Fast Saves: See our “Deflating bloated files” Secret, later in this chapter.

■ Fractional Character Widths: See “Master fractional character widths,” earlier.

■ Show Heading 5: If you use the outliner, you’ll discover that Word’s one-click level-
collapsing buttons only go up to 4! There’s no way to see additional levels unless you add Show Heading 
commands to your menus.

■ Sentence Case: It’s invaluable when you get an e-mail or other document that’s been typed 
in all capital letters. This command converts text to normal upper/lowercase instantly.

■ Small Caps: This is a priceless, good-looking style variation for subheads and titles.

■ Redefine Style from Selection: If you use Word’s Styles feature, described earlier, you’ll love
this. Add this command to the menu, and you can change every occurrence of a style in one step. (The 
alternative is to use the Style pop-up menu on the ruler, which involves several steps.)

begin sidebar: Answer Man



Sine qua non

Q. Oh, great. I was so impressed with your earlier section on using the 
Remove From Menu command to remove unneeded items from my menus 
that I got carried away and removed the Commands command itself. Now 
what do I do? I can’t open the Commands dialog box to put the Commands 
command back on the menu!

A. Yes, you can. Even if you delete the Commands command from the Tools 
menu, you can still open the Commands dialog box by using the keyboard 
command ⌘-Option-Shift-C.

end sidebar 

M i c r o s o f t  W o r d  S e c r e t s  
Solving the space-before-paragraph dilemma
When defining a Word style, you can specify the amount of 
blank space you want to appear before each paragraph. 
This gives you consistent spacing throughout a document. 
Trouble is, if a paragraph formatted with leading space 
appears on the top of the page, the space preceding the 
paragraph creates the appearance of an overly wide top 
margin. 

How can you get rid of the extra space at the top of the 
page? Here are two solutions:

The laborious method: Select the paragraph at the top of 
the page. Open the Paragraph dialog box (⌘-M). Change 
the number in the Spacing Before box to zero. 
Click OK.

The easier way: Define a second version of the paragraph’s 
style, identical to the first style in every way, except that it 
includes no space before the beginning of the paragraph. If,
after repaginating your document, you find a paragraph 
with extra space at the top of a page, apply the secondary 
style to eliminate the extra space.

Removing more than one menu item at a time
You can remove multiple menu items without having to 
repeatedly press ⌘-Option-minus sign. The trick is to hold 
down the Shift key as you remove each item; this will keep 



you in Remove From Menu mode so you can continue to 
select items for removal. 

To make this work, you have to press the Shift key after the
fat minus sign appears but before you pull down a menu to 
select the first item to remove. 



By the way, if you activate either the Add to Menu or 
Remove From Menu command and then change your mind, 
you can escape by pressing ⌘-. (period). 

Keyboard control in dialog boxes (Word 5)
Almost every button in Word’s Spell Checker and 
Thesaurus can be triggered with keystrokes. In many Word 
dialog boxes and windows, such as the Word Count (in 
versions prior to 6.0) and Save As dialogs, you can use 
keyboard shortcuts to select and deselect checkboxes and 
other options. For example, you can simply type the letters 
C, W, L, or P to select and deselect the checkboxes in the 
Word Count dialog box.

In most dialog boxes that don’t contain a text field, you can 
trigger buttons by pressing only the first letter of the 
button’s name — without any modifier keys. For example, in
Yes/No dialog boxes, instead of clicking the Yes, No, or 
Cancel buttons, type a Y, N, or C. (This is a great shortcut! 
When you quit Word, don’t even wait for the “Save changes
before closing?” box. Type a bunch of Y’s or N’s in rapid 
succession, without even waiting to be asked.)

In dialog boxes that do contain a text field, you generally have to 
press ⌘ as well as the first letter of the button’s name (see 
Figure 17-18) so that Word won’t think you are trying to type into
the blank. 
Ô-IÔ-CÔ-OÔ-.Ô-AÔ-S

Figure 17-18: Using 

the Command-key shortcuts in Word’s Spelling dialog box.
One more trick: when a dialog box is on the screen, you can
cycle through the various buttons, pop-up menus, and text 
fields by pressing ⌘-Tab (or Shift–⌘-Tab to move backward 
through them). Word indicates that you’ve “selected” one of
these elements by drawing a strange flashing underline 



beneath it. To select the one you’ve just flashed — to put an
X in the checkbox, for example, or to choose an item in a 
pop-up menu you’ve opened — press the zero key on the 
numeric keypad (Num Lock must be off).

Picking the paragraph



You can select the invisible, nonprinting paragraph mark 
(¶) at the end of a Word paragraph quickly — and without 
having to turn on the Show ¶ command — by pointing to 
the end of the paragraph and double-clicking in the white 
space right after the last word of the paragraph (see Figure
17-34). 

Why bother? Here’s one good reason: Word stores each 
paragraph’s formatting — style, margins, font, and so on — in 
that little paragraph mark. By copying a paragraph mark and 
pasting it at the end of another paragraph, you transfer all of the 
first paragraph’s formatting to any other part of a document.

The art of paragraph splitting
Suppose you want to split a paragraph into two separate 
paragraphs. Generally, you do this by positioning the 
insertion point at the split and pressing Return to insert a 
new paragraph mark. That works, but it moves the 
insertion point to the beginning of the new paragraph. If 
you have anything else to add to the previous paragraph, 
you must navigate back.

Versions of Word prior to 6.0 have a special paragraph-
splitting command, ⌘-Option–Return, which makes this a 
little easier. This command divides the paragraph as 
described, but it places the insertion point at the end of the
first paragraph so that you can add more to it.

Gray text
Word’s text colors can be used to print halftoned text on a 
laser printer (if you have Version 6.0 or later of the 
LaserWriter driver). Yellow, cyan, and green create lighter 
gray text, while magenta, red, and blue print darker grays.

Tracking and kerning
Word offers two methods of adjusting the space between 



characters. The Character dialog box (or, in Word 6.0, the 
Font dialog box) lets you finely adjust the overall tightness 
of letter spacing. And Word’s code-like formula typesetting 
command lets you do actual kerning. (See Chapter 24 for 
more on tracking and kerning.)



Tracking: In the Character dialog box, you can expand or 
condense selected text in 0.1 point increments, using the 
Spacing commands. In versions of Word prior to 6.0, you’re 
limited to .25-point increments and you can expand character 
spacing only up to 14 points or condense spacing up to 1.75 
points (see Figure 17-36).

Granted, using the Character or Font dialog box isn’t the most 
convenient way to tighten text. But remember, you can add these
commands to a menu (as shown in Figure 15-37) or assign them 
keyboard shortcuts to speed up formatting. (Try ⌘-left arrow for 
tighter spacing, for example, or use whatever keystroke matches 
the kerning command in your favorite page layout program.)

Kerning: This method of kerning isn’t nearly as convenient
or as flexible as it is in page layout programs. You can only 
move characters closer together or farther apart in one-
point increments. And you have to use Word’s typesetting 
formula commands — in this case, the Displace command. 
Furthermore, this technique doesn’t work in Word 6.0.

To use the formula typesetting approach, it helps to pick 
Show ¶ from the View menu (or press ⌘-J). 

To tighten the space between two characters, position the 
insertion point between them and press ⌘-Option-\ to begin
the formula. Next, type the letter d, which stands for the 
Displace command.



Then press ⌘-Option-\ again, and follow this with the 
letters ba. The ba stands for backwards, telling Word you 
want to move the characters closer together. Type the 
number of points you want to move the characters (a whole
point value; no fractional amounts) and close the formula 
with empty parentheses ().

If you wanted to kern letters closer together by two points, 
therefore, the formula would look like this: 

\d\ba2()

When you choose Hide ¶, the formula disappears and the 
effects of the kerning become visible. 

To move characters farther apart, follow the same formula, 
but replace the ba with fo, the abbreviation for forward 
spacing. To move two characters apart by one point, then, 
you type the formula: \d\fo1() exactly as it appears here.

Obviously, all this formula typing is tedious. The best strategy is 
to save the finished formulas as Glossary entries, add them to 
your Work or Format menu, and assign them keyboard shortcuts 
(see Figure 17-38).

Figure 17-38: You can save yourself the hassle of repeatedly typing Word’s 
formula typesetting commands by saving them as Glossary entries, adding them to 
a menu, and assigning them key combinations. In this example, the \d\ba1() 
command, which moves characters together by one point, is saved as an entry 
named Kern-1and assigned the keystroke ⌘-Control-K.

A word of caution about using these typesetting formulas: After you insert a 
formula into a word, it effectively splits the word in two, even 



though the word appears unbroken. Double-clicking a word bisected by a Displace 
command only selects half the word. And the Word Count command considers a 
word containing a kern formula as two separate words!

Copy formatting
You can copy the format of one selected portion of text and 
apply it to another selection without copying the text itself. 
To do so in versions of Word prior to 6.0, select the text 
with the format you want to copy and press ⌘-Option-V. In 
the lower-left corner of the document window, you see the 
words “Format to” (see Figure 17-39).

Then select the text to which you want to apply the formatting. 
The selection appears with dotted underlining. Press Return or 
Enter; the format characteristics of the first selection are applied
to the second.

Alternatively, you can transfer formatting using this 
method: Press ⌘-Option-V without selecting text. Once 
again, you see the “Format to” message in the window. 
Select the text with the format you want to copy and press 
Enter or Return. Then place the insertion point wherever 
you want and start typing; the format attributes you copied 
will be applied to anything you type. 

Here’s the thing to remember: The formatting you copy 
using the Format to command depends on what you select. 
If you select an entire paragraph, the command will copy 
the paragraph-level formatting; if you select a string of text
within a paragraph, then the command copies the 
character-level formatting.

In Word 6.0, all of this is much easier. All you have to do is 
use the Copy Format and Paste Format commands to 
transfer formatting. (If these commands don’t appear in 
your Edit menu, you can put them there using the 
Customize command.)

Customized spacing



Word doesn’t contain any tools for precisely adjusting the 
spacing between individual words. But you can rig up some
custom-sized spaces using the following method: select a 
character with the width of the custom space you want to 
create. Then, using the Color pop-up 



menu in the Character dialog box (⌘-D), pick White as the 
color of the character.

The character becomes invisible and can be used as a 
space. Use large characters to make wide spaces; use tiny 
characters, such as punctuation marks, to make narrow 
spaces.

To make the whited-out characters readily available for 
spacing, save them as Glossary entries, add them to your 
Work menu, and assign them keyboard equivalents. When 
you save the spacing characters in the Glossary, all the 
formatting, including the White color, are preserved.

Alternatively, you can add White as an option in the Format 
menu. You can also create a keyboard shortcut for applying 
White, using the Add to Menu or Add to Key commands.

Transferring headers and footers to a new document
You can copy the headers and footers from one Word 
document to another by copying and pasting a single 
character — the paragraph mark at the end of the last 
paragraph in the document (see Figure 17-44).

The final paragraph mark, which appears as a grayed-out ¶ 
symbol when you choose the Show ¶ command, contains all the 
document’s header and footer information. When that mark is 
pasted into a new document, the document inherits the headers 
and footers of the source document.

The amazing thing is that after you paste the paragraph 
mark into the new document, you can go ahead and delete 
it; the header and footer information remains in place. 

Solving the space-before-paragraph dilemma



When defining a Word style, you can specify the amount of 
blank space you want to appear before each paragraph. 
This gives you consistent spacing throughout a document. 
Trouble is, if a paragraph 



formatted with leading space appears on the top of the 
page, the space preceding the paragraph creates the 
appearance of an overly wide top margin. 

How can you get rid of the extra space at the top of the 
page? Here are two solutions:

The laborious method: Select the paragraph at the top of 
the page. Open the Paragraph dialog box (⌘-M). Change 
the number in the Spacing Before box to zero. 
Click OK.

The easier way: Define a second version of the paragraph’s 
style, identical to the first style in every way, except that it 
includes no space before the beginning of the paragraph. If,
after repaginating your document, you find a paragraph 
with extra space at the top of a page, apply the secondary 
style to eliminate the extra space.

Editing large tables
Unless you have a very large monitor, editing big tables can
be exasperating. You have to continually scroll back to read
row headings in cells that are no longer in view.

Here’s a trick to make it easier. Open the table in a second 
window and keep that window scrolled to the row headings. Line 
the window up with the first window, and you can read the row 
headings and the cells all the way across the page — at the same 
time (see Figure 17-46).

Exporting Word tables
Got a table in Word? If you try to export it to a graphics or 
page layout program using the standard Copy command, 
you’ll be in trouble. When you paste the table into the new 



program, you lose the table’s formatting, gridlines, and cell
spacing.



To export tables successfully, use the Copy as Picture 
command (⌘-Option–D). That copies the entire table as one
graphic, as a PICT file with all the formatting intact.

Here’s a really neat twist: If you paste a Word table into an 
object-oriented drawing program after copying it with the 
Copy as Picture command, you can still edit it. Each 
element of the table — including all the text entries and the
individual grid 
lines — becomes a separate object that can be moved, 
deleted, or altered independently. Fonts can be changed, 
text can be retyped, gridlines can be thickened, and the 
whole table can be stretched, resized, or distorted.

Making tables scroll faster I
The Copy as Picture command described in the previous 
Secret (⌘-Option–D) can speed up scrolling in Word itself. 
Use the Copy as Picture command (it’s called Copy Picture 
in Word 6) to copy a whole table. Then paste it back into 
the same document, replacing the original table with a 
graphic — a PICT file — of the table. (You might have to 
exit to the Finder and then return to Word in order for 
Word’s clipboard to convert the copied table into a PICT 
image.)

The advantage of this system is that Word scrolls through a 
picture of a table much faster than it can scroll through the
table itself. You completely bypass that painful row-by-row 
appearance of a table. For even more scrolling speed, 
choose the Picture Placeholders option in the Preferences 
dialog (or Options, in Word 6) to temporarily hide all the 
graphics in a file.

Of course, replacing a table with a picture of a table means 
you no longer can tab through the table, adjust the size of 
its cells, or edit the text as you can on a regular table. (See 
the next Secret.)

Making tables scroll faster II
So what happens if you replace your tables with uneditable 
PICT graphics, as described in the previous Secret — and 
then you discover you need to make a change in the table?



No sweat. Just double-click the graphic. This opens a picture of 
the table in Word’s Edit Picture window. In the editing window, 
you can select each element of the table graphic as a separate 
object and move, delete, or edit it (see Figure 17-47). So if you 
decide you want to change the font used in the table headings, 
just select all the headings and choose a new font from the Font 
menu. Using the editing tools in the window, you can edit the 
text, change the color of any table 



element, and delete data if necessary.

Creating custom borders 
This Secret isn’t for everyone; it’s slightly more 
adventurous because it involves typing PostScript code 
directly into Word to precisely set the widths of borders in 
tables. This works only if you are using a PostScript printer 
(or PostScript emulation software, such as Freedom of 
Press, that can interpret the code for a QuickDraw printer).

To set the width of a cell border to 1.5 points, for example, 
you type the following code into the cell:

.cell.1.5 setlinewidth
wp$box stroke 

After you enter and highlight, your next step is to apply the 
PostScript style to it. Press the Shift key; from the Styles 
pop-up menu on the Ruler, select PostScript (a style you 
may not have seen before). The code is formatted as hidden
text and disappears (unless you have the Show Hidden Text
option selected in the View menu). The results of the code 
are visible only when you print to a PostScript printer.

Justification on the last line of a paragraph
The last line of a justified paragraph normally remains 
left-aligned — and that’s the way it usually looks best. But 
if you want that last line to be justified, too, press Shift–
Return at the end of the last line of text (see Figure 17-
50).





Copying section formatting
Word stores all the formatting for a section in the section 
mark, the double dotted line that runs across the screen at 
the end of a section. You can copy the formatting — fonts, 
line spacing, margins, and so on — for an entire section by 
simply copying the section mark. When you paste the mark 
at a new location, all the text preceding it takes on the 
formatting stored in the mark. 

Incidentally, you can double-click any section mark to open 
the Section dialog box. (In Word 6, this opens the Page 
Layout dialog box.)

Nisus

We don’t use this high-horsepower, multiple-
Undo, programming-languaged word processor 
much. Here are a few Secrets worth passing on, 
however.

N i s u s  S e c r e t s
Quick access to dumb quotes
As we discussed earlier, curly quotes go a long way toward 
making documents look typeset. But they’re just wrong 
when used to indicate feet, inches, and minutes.

In Nisus, you turn on smart quotes in the Editing 
Preferences dialog box. What’s nice is that, to override that
setting for just one inch mark (for example), you just press 
the ⌘ key while typing the quote mark. It comes out 
uncurly.

(As a matter of fact, this works in reverse. If the Editing 
Preferences are set not to display curly quotes, the ⌘ key 
will produce one.)

Jump between windows
The window title bars in Nisus work just like the Finder’s! 
If you press the ⌘ key and click a window’s title, a 
submenu appears, listing all open windows. From it, you 



can jump to any other window by choosing a window name.

Window zooming
Double-click a window’s title bar to make it zoom to its full 
size. Double-click a second time to restore the window to 
its original size.

WriteNow



WriteNow is a great little word processor with a 
size that belies its power. The program itself 
takes up a ludicrously tiny 276K on your hard 
drive and requires less than 600K of RAM to run
— yet it’s full-featured and fast, with easy-to-use 
formatting tools and good keyboard shortcuts.

Here are a few of our favorite tricks for getting 
the most out of the program.

W r i t e N o w  S e c r e t s
Using character styles
One of WriteNow’s best features is its support of character-
level styles. This lets you save a set of formatting 
characteristics — font, size, or style, for instance — and 
apply them all at once to some selected text without 
actually changing any paragraph styles.

This can be extremely useful if, for example, you’re writing 
a play script and you want dialogue to appear in one font, 
but parenthetical stage directions to appear another, italic 
font. 

If you created a separate paragraph style for each (as you 
might in Microsoft Word), the stage directions and dialogue
would have to appear in separate paragraphs. But, by 
creating two character-level styles — one for dialogue and 
one for stage directions — the two styles are combined 
within a single paragraph:

MS. PAPAYA: (adamantly) You heard what he said. Now, do it!

DOUG: (gasping, suddenly) I guess there’s nothing more to discuss. (He begins scribbling notes 
furiously.) 

MS. PAPAYA: (shaking her head) From the bottom of my heart, I pity you. 

And because these are actual styles, you can subsequently change their look, everywhere in 
the document, in one step.

You can assign a keyboard command to a character style, as explained in the 
next tip.



Keyboard shortcuts for character and paragraph 
styles
WriteNow allows you to assign a keyboard shortcut to any 
paragraph or character style when you create it (but you’re
limited to 11 available ⌘-key combinations). 

When setting up a new style in the Paragraph Style (or Character
Style) dialog box, just pick a ⌘-key combination from the 
Command-Key pop-up menu. The key command will 
automatically be linked to the style (see Figure 17-52). WriteNow
automatically grays out key 



combinations that are already linked to other commands.

Pop-up menus for paragraph and character styles.
Instead of choosing paragraph or character styles from the 
Custom menu, you can use the status bar at the bottom of 
the document window. The pop-up menu on the left gives 
you access to all currently saved paragraph styles, and the 
pop-up menu on the right lists all saved character styles. 
(These pop-up menus don’t appear until you save at least 
one custom style.)

Transparent styles
Generally, applying a character style produces text in a 
specific font, size, and style. But with WriteNow, you also 
create transparent styles — styles that change only the 
font, only the size, or only the style when applied — without
affecting any other formatting.

You can create a bold, double-underlined transparent style, 
for example. When you apply the style to text in any 
paragraph, the font and size of the text remain unchanged, 
but boldface and underlining are added.

You create a transparent style by selecting and deselecting 
checkboxes in the Character Style dialog box. In Figure 17-54, 
only style and color are checked, so the new style changes the 
style and color of text to which it is applied, but it doesn’t affect 
font, size, and 



superscript/subscript formatting.

Fast page navigation
To move to another page of a WriteNow document quickly, 
double-click the page number box in the lower-left corner 
of the document window. A dialog box appears. Type in the 
number of the page you want to view. Click OK or press 
Return.

Copying character formats
You can quickly copy the font, size, and style of a selected 
block of text — without copying the text itself — and 
transfer that formatting to another block of text.

First, select the text that has the format you want to copy. 
Use the Copy Font-Size-Style command — or just press ⌘-
3. Then select the text you want to inherit the style and 
press ⌘-4, the Paste Font-Size-Style Command.

Global formatting changes
There’s a variation on the Copy Font-Size-Style command 
that lets you change the format of all text in a document 
sharing identical attributes. In other words, you can change
every occurrence of 10-point New York bold to 12-point 
Helvetica italic — without affecting any other text in the 
document.

First, change the font, size, or style of the first chunk of 
selected text according to your preference. Press ⌘-3 or 
select the Copy Font-Size-Style command.

Select all the remaining text in the entire document. Then 
hold down the Shift key while choosing the Paste Font-Size-
Style. All the text that was formatted identically to the 



original selection takes on the new style attributes.



Copying ruler settings
To quickly transfer the margins, spacing, alignment, and 
tabs of one paragraph to another, use the Copy Ruler 
command. First, select the paragraph containing the ruler 
settings you want and press ⌘-1. Then select the 
paragraph or paragraphs to which you want to transfer the 
formatting and press ⌘-2 (the keyboard shortcut for the 
Paste Ruler command). Fonts, size, and style aren’t affected
— only margins, spacing, alignment, and tabs.

Superscript and subscript shortcuts
You can change the vertical position of any selected 
characters to create subscripts and superscripts from the 
keyboard. Pressing ⌘-H (which stands for “higher”) pushes
the selection up in one-point increments. Pressing ⌘-L 
(“lower”) moves the selection down in one-point 
increments.

Interestingly, this works with pasted-in graphics, too. After 
you paste in a picture, you adjust its vertical positioning by 
using the same two commands.

Saving compactly
Though you may not realize it, WriteNow always stores two 
copies of a document on disk — the version you most 
recently saved using the standard Save command and 
another version of the document as it existed before you 
last saved it. (The two versions are stored within one file; 
that’s why you never notice this.) The Revert to Backup 
command is your safety net; it retrieves the version of the 
document as it was before your last save.

However, keeping that second backup version of a 
document takes up space; it bloats the size of the document
file. If you want to eliminate the backup, press the Option 
key when you choose Save from the File menu. The Save 
command changes to Save Compact. WriteNow saves a 
slimmed-down version of the file, minus the backup. Of 
course, this means you won’t be able to use the Revert to 
Backup command on that document.



Roll credits
To view WriteNow’s cleverly animated programmer’s 
credits, choose About WriteNow from the Apple menu to 
open the credits box. Click anywhere in the box while 
holding down the Option key. 

An army of tiny people come running in, grabbing the 
letters in the programmers’ names, and rearranging them 
to spell out the names of other individuals who helped with 
the program. Meanwhile, a bulldozer cruises through from 
the right and plows over the copyright notice.



MacWrite Pro

This most recent entry in the Mac word 
processor marketplace is marked by Claris 
Corp.’s usual elegant, clean design. It’s not 
nearly as overwhelming as Word or WordPerfect 
— nor as big, nor as memory-hungry — yet it has
many of the same features. For example, it has a
spelling checker that can even check while you 
type; a thesaurus; automatic hyphenation; a 
table feature like Word’s; and a powerful frame 
feature that, among other things, lets you wrap 
text around irregularly shaped graphics.

M a c W r i t e  P r o  S e c r e t s
The importance of Page Setup
In any word processor, your choice of printer (in the 
Chooser) makes a big difference in the layout of your 
document. Switching from ImageWriter to LaserWriter, in 
particular, can completely change the way line breaks and 
page breaks fall in your document.

In MacWrite Pro, selecting the correct printer is especially 
important because the program resizes its frames when you
change your Page Setup or Chooser selection. Therefore, 
be sure to choose the correct printer driver and Page Setup
options before you create a document. Otherwise, when 
you change drivers, all frames will change size. You’ll have 
to spend some time fussing with the document to restore it 
to its previous look.

A shorter ruler
When you’re working on a PowerBook, a Classic, or any 
compact Mac model, you may want to collapse the ruler 
during your major inspiration bouts. With a smaller ruler, 
you can see more of your typing.



To collapse or uncollapse the ruler, double-click the bottom 
half of it.

Of course, you can hide the ruler completely, if you wish, by
pressing ⌘-H.

Double-click tricks
Double-click the top half of the ruler to see the Document 
dialog box, where you can change the margins and page-
numbering system.

Double-click a tab stop on the ruler to open the Tab dialog 
box, where you can specify detailed information about tab 
stops (and specify that the selected paragraph shouldn’t be 
separated from the next one over a page break). 



Option–double-click the page number indicator (lower-left 
corner of the screen) to open the Preferences dialog box. 

Open an existing document directly on startup
Under normal circumstances, when you double-click the 
MacWrite Pro application icon, you get a new blank 
document. Instead, if you want to open an existing 
document on your disk, press ⌘ as the program is 
launching. You are presented with the usual Open File box, 
from which you can select the existing document you want 
to open.

Change the margin visually
Option-drag a margin guide, a column guide, or a frame 
edge to move it (the cursor changes to a little grabber 
arrow). As you drag one of these nonprinting guidelines, 
you see its measurements in the lower-left corner of the 
window. Without the Option key, you can’t budge these 
light gray lines (see Figure 17-63).

Quick zooming back and forth

One of MacWrite Pro’s most unique features is that you can
enlarge or reduce the display of your document and still 
have full editing capabilities.

Double-click the Percentage box (in the lower-left corner of 
the window) to type in a new zoom level (for example, type 
200% to see the text twice as big). 

After you zoom to a different level, you can single-click the 
Percentage indicator to switch back and forth between 
actual size and the zoomed in (or out) size.

PowerBook scrolling keys
MacWrite Pro makes good use of the Page Up, Page Down, 
Home, and End keys found on an extended keyboard. But 
that’s not of much help to PowerBook users, or anybody 
whose keyboard doesn’t have this extended set of keys.



Fortunately, there are equivalent shortcuts for non-
extended keyboards. They are:



Control-K and Control-L (to scroll up or down by a 
screenful) 

Shift-Control–K and Shift-Control–L (to scroll up or down by
a page)

Control-D and Control-A (to jump to the end or beginning of
the document)

Cursor manipulation keys
Here, for your reference, are the key combos for making 
the cursor jump around:

Jump by one word: Option-arrow key

Jump to the start or end of the line: ⌘-arrow key

Jump up or down a paragraph: Option-arrow key (left or 
right)

Jump to the beginning or end of the document: Option-
arrow key (up or down)

Add the Shift key to any of these combos to select the text 
as you move the cursor.

Search-and-replace Secrets
When you use the Find/Change dialog box, you can use 
wildcard searches. Use \? to represent a character you 
don’t want to specify, and \* to specify any number of 
unknown characters.

Suppose that you search for B\?G. Your Find command locates 
words like bag, beg, big, bog, and bug — but not being or 
bowing. To find being or bowing (because they have several 
unspecified characters in between), you search for B\*G (see 
Figure 17-64).

Also, keep in mind that you

can paste into the Find/Change box. If you receive a file from an 



IBM user, for example, and it’s full of strange boxlike characters, 
you can search for them and replace them all with nothing. Just 
paste one of the little boxes into the Find box (and leave the 
Change box empty).

Resize a graphic



To resize a graphic by some fixed numerical percentage, 
click to select its frame and then double-click the 
illustration itself. A dialog box appears, in which you can 
specify an exact new size.

On the other hand, you may have more fun by Option-dragging a 
graphics frame’s handle. That resizes the graphic visually and 
doesn’t preserve the original graphic’s proportions. Which, in 
some cases, is just what you want (see Figure 17-65).

      

Creating a table and selecting cells in it
Claris, as far as we can tell, borrowed Microsoft Word’s 
fantastic Table feature. This feature prevents the kind of 
formatting hell that usually results from trying to use tabs 
to line up pieces of text that don’t fit in an allotted space. 
Figure 17-66 makes this syndrome all too clear.

Figure 17-66: This is a job for 

Tables. If you try to create a table using tabs, this sort of 
misalignment is almost inevitable. See how the second line
wraps inappropriately to the first column? See how the 
name in the third line is too long, so it pushes past the tab
stop and gets everything out of whack?
If you use a table, however, you won’t have this problem 
(see Figure 17-67).



Figure 17-67: Use MacWrite Pro’s table feature to keep everything in line. Each 
piece of text now wraps only within its particular cell.

Use the Insert Table command (Frame menu) to pop a table into your document. 
After you’ve done so, you can highlight various portions of the table as follows:

■ ⌘-click a cell to select it.

■ Drag across to select multiple cells or click the first one. Shift-click the last one.

■ ⌘-click to select nonadjacent cells.

■ ⌘-drag to resize a table column without changing the width of other columns.

Dialogue
How low can you go?

JS: Hey, David. I’ve figured out how I can change to a new 
Word 5.1 style sheet without even lifting my fingers from 
the keyboard.

DP: Say, Joe, nice going. What’s the secret?
JS: All you do is hit ⌘-T to open the Styles dialog box. Then 

press the up-down arrow keys to highlight the name of the 
style you want, and press Return!

DP: Way too many keystrokes. I bet I can do it in only four 
keystrokes.

JS: How on earth?
DP: All you have to do is press ⌘-Shift–S. The word Style 

shows up in the status bar at the bottom-left corner of the 
document window. Then I just type the first couple letters 
of the style name, press Enter or Return, and that’s it. 

JS: All right, big shot. I bet I can change styles without 
pressing any keys.

DP: This I gotta see.
JS: I can just choose a style’s name from the ruler, like this!



DP: That’s cheating. You used the mouse.
JS: Okay, well, if I can’t use the mouse, then I bet I can change 

styles with only one keystroke.
DP: No way!
JS: Yes way. All you do is choose Commands from the Tools 

menu. Scroll till you see Apply Style Name. In the right side 
of the dialog box, choose the name of the style you want to 
switch to. In the lower-right corner of the box, click Add, 
and type the one key you want to use. 

DP: Cute. Real cute. I guess the only thing left for me to do is 
point out how I switch to a certain style without typing any 
keys or using the mouse at all.

JS: What is this? You’re going to tell me you’ve got your Mac 
hooked up to some Casper voice-recognition system?

DP: No. What I did was I opened up the Styles dialog box (⌘-T). 
I clicked Normal, and I made all these changes to it. I like 
Palatino 12-point, 1.5-line spacing, with open paragraphs. 
So I changed my Normal style to that. Then, to boot, I 
clicked Use As Default, so every new Word document will, 
in effect, automatically switch to the style I prefer, without 
my having to lift a finger.

JS: Oh, yeah? Well, let’s see you balance as many pennies on 
your elbow as I can.

end  Dialog

Chapter 18 (Page Layout)
Avoid losing your manual font changes
When you change a paragraph’s Style assignment, 
PageMaker is fairly intelligent: it doesn’t nuke any 
character variations, such as bold and italic, that you 
applied to individual pieces of text in that paragraph.

It does, however, wipe out any font variations. If you placed
a character or two from a symbol font, for example, or used
the Chicago font to create symbols like ⌘ or @apple, the 
font changes to that of the rest of the paragraph when you 
reapply a style.

There’s a trick, though, if you’re using a version of 
PageMaker prior to 6.0: press Shift as you double-click the 
new style’s name on the Style palette. Then PageMaker 
applies the new style, but won’t disturb any font changes 
you made by hand. 


